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Module 1 Het gebruik van Maple, inleiding

Inleiding tot het gebruik van Maple.Onderwerp

Geen.Voorkennis

+, -, *, :=, ’ ’, :, ;, #, %,%%,%%%, ?, restartExpressies

Module 2.Zie ook

1.1 Voordat u begint. . .

Er zijn diverse manieren om met Maple te werken, de zogenaam-

de user interface. In dit boek zullen we voornamelijk werken met

Standard Maple 14 (de andere versies zijn: Classic Worksheet

Maple 14 en Command-line Maple 14 ). Onder het Programs-menu op

uw PC zal de standaardversie waarschijnlijk gewoon onder de naam

Maple 14 te bereiken zijn.

Deze standaard-versie heeft nog twee verschillende varianten: de

document mode en de worksheet mode. Zoals de naam al zegt, is

de eerste versie vooral bedoeld om netjes opgemaakte documenten

te maken. Een beetje oneerbiedig gezegd is dat eigenlijk een soort

‘tekstverwerker met ingebouwde rekencapaciteiten’. Wij zullen uit-

sluitend in de worksheet mode werken, want dan hebben we veel beter

onder controle welke rekenopdrachten we precies geven. Helaas is het

de standaardinstelling van Maple om in document mode te werken,

en we moeten dus meteen aan het begin uitdrukkelijk aangeven dat

we dat niet willen (en de worksheet mode dan natuurlijk tot de stan-

daardinstelling maken).

Als u het programma start, dan ziet u waarschijnlijk eerst een

Startup-venster. Kies hierin: Start with Blank Worksheet. Kies ver-

volgens in de bovenste menubalk Tools→ Options. . . en in het venster

dat dan opent het tabblad Display. Verander zonodig Input display in

Maple Notation. Kijk vervolgens onder het tabblad Interface en veran-

der Default format for new worksheets in Worksheet. Klik tenslotte op

Apply Globally en u hebt precies dezelfde instellingen als die waarmee

de voorbeelden in dit boek zijn gemaakt.

Het kan overigens best zijn dat u zelf de voorkeur geeft aan 2-D Math

Notation voor de Input display, vooral als u gewend bent aan de één of

andere ‘formule-editor’. Experimenteer daar eens mee, bijvoorbeeld

aan de hand van opgave 1.2.
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4 Module 1

1.2 Het werkblad

Als Maple is gestart vertoont het scherm een leeg werkblad (work-

sheet) dat als volgt is opgebouwd:

• De eerste regel geeft tegen een blauwe achtergrond de tekst:

Untitled(1) – [Server (1)] – Maple 14;

• de tweede regel, met File Edit View Insert Format . . . is

de Menu bar. Als u een van deze woorden aanklikt), dan

verschijnt er een submenu waaruit u kunt kiezen;

• de derde regel is de Tool bar, een hele rij met zogeheten but-

tons. De betekenis van deze buttons wordt kort aangegeven

als u met de muis de cursor er naartoe beweegt;

• daaronder staat de Context bar, een tweede Tool bar die

afhangt van waar u mee bezig bent;

• links staat een kolom met zogenaamde paletten. Deze kun-

nen soms behulpzaam zijn bij het invoeren van ingewikkelde

commando’s of ongewone symbolen.

• ten slotte een wit veld, het eigenlijke werkblad, met links-

boven het symbool [> (de input-prompt).

1.3 Berekeningen: exact en nume-
riek

Maple is een verzameling computerprogramma’s (een ‘pakket’) en is

bedoeld als hulpmiddel bij het analyseren en oplossen van wiskundige

problemen. We kunnen Maple gebruiken voor uiteenlopende zaken,

zoals manipulaties met wiskundige formules, oplossen van vergelij-

kingen, numeriek rekenen en tekenen van grafieken.

Maple is een interactief pakket. Dit betekent dat de gebruiker via

het toetsenbord aan Maple opdrachten kan aanbieden, waarna Maple

direct probeert deze naar beste kunnen uit te voeren. We lichten dat

toe aan de hand van een voorbeeld.

Voorbeeldopgave

Bereken
17 + 18

2 × 5 − 1
; Bereken

√
2.

De ‘opdrachten’ zullen hier eenvoudigweg uit formules bestaan. Om

Maple aan te geven dat de gehele opdracht is ingevoerd, zodat het
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Het gebruik van Maple, inleiding 5

kan beginnen met de uitvoering hiervan, moet de opdracht worden

afgesloten met een dubbele punt en de [Enter]-toets of een puntkom-: ;

ma en de [Enter]-toets. In het eerste geval (dubbele punt) wordt het

resultaat van de uitvoering niet, in het tweede geval (puntkomma)

wel aan de gebruiker getoond. In beide gevallen wordt de berekening

echter wél uitgevoerd. Wanneer de : of de ; wordt vergeten, maar

wel een [Enter] wordt gegeven, dan start Maple wél met de opdracht,

maar geeft een waarschuwing dat het zelf een ; heeft toegevoegd.

Dus:

• Puntkomma of dubbele punt betekent: ‘opdracht klaar’;

• Indrukken van de [Enter]-toets betekent: ‘begin met de uit-

voering van de opdracht(en)’.

Een opdracht aan Maple noemen we ook wel een statement.

Voorbeeldsessie

> (17+18)/(2*5-1);

35

9

> 2^(1/2); 2^(0.5);
√

2

1.414213562

Toelichting

Kennelijk laat Maple het antwoord (35/9) staan, en maakt hiervan

niet 3.88 . . .

Dit is in het algemeen zo: Maple probeert exacte antwoorden te geven

als de invoer ook in exacte vorm is gegeven. Zodra in de invoer

minstens één getal met een decimale punt voorkomt, wordt dat getal

als een afronding, dus als een decimale benadering van een reëel getal

gezien.1 In dat geval wordt het antwoord ook in decimale benadering

gegeven, zoals het tweede voorbeeld laat zien. Later, in Module 3,

zullen we zien hoe ook van een exact antwoord een benadering kan

worden verkregen.

Het teken > aan het begin van een regel heet de prompt, en geeft>

aan dat Maple op nieuwe invoer wacht. Er kunnen verschillende op-

drachten in één invoerregel worden gegeven (zoals in de tweede regel

van het voorbeeld is gebeurd). Maple begint pas met het uitvoeren

van de opdrachten als op de [Enter]-toets wordt gedrukt en geeft de

resultaten onder elkaar. ⋄

1Zie verder §2.1 voor (decimale) getallen
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6 Module 1

! Let op dat ‘kommagetallen’ niet met een komma, maar met

een punt worden genoteerd. Dus niet : 3,14, maar: 3.14.

Commentaar. ‘Opdrachten’ die beginnen met het teken # worden#

niet opgevat als opdracht, maar als commentaar. In feite wordt alles

wat achter # staat door Maple genegeerd, het mag dus ook na de

puntkomma van een gewone opdracht worden gebruikt.

1.4 Execution groups

Als de input-prompt zichtbaar is kunt u beginnen met een Maple-

commando in te typen; dergelijke commando’s (Maple input) worden

in rode letters op het scherm weergegeven. Een inputregel wordt aan

het programma doorgegeven (dat wil zeggen dat de betreffende op-

dracht wordt uitgevoerd) als u [ Enter ] indrukt. Het resultaat (2D

Output) komt in blauwe letters op het scherm.

Als er een fout is gemaakt kunt u een bestaande inputregel verbeteren

door met de muis of de pijltjestoetsen de cursor op de fout te zetten,

deze te verbeteren en (meteen) op [ Enter ] te drukken. U hoeft daar-

voor niet eerst de cursor naar het einde van de betreffende regel te

verplaatsen. U zult er wel even aan moeten wennen dat [ Enter ] in

dit geval niet betekent: “ga naar een nieuwe regel”, maar: “voer de

opdracht(en) van deze regel uit.”2

[ Enter ] geeft dus alle bij elkaar behorende opdrachten (die eventueel

meer dan één regel kunnen beslaan) door aan het programma. Wélke

opdrachten bij elkaar horen is te zien aan de vierkante haak ( [ ) aan

de linkerkant. We noemen dat een execution group. Als u op [ Enter ]

drukt in een rood Maple-commando springt de cursor, na uitvoering

van de opdracht, automatisch naar de volgende execution group, er

wordt een nieuwe gemaakt als we onderaan het werkblad zijn.

Een nieuwe execution group wordt gemaakt met de [> -button in

de toolbar. Ook het Insert-submenu in de menu bar is daarvoor te

gebruiken.

Een hele execution group, dus inclusief eventuele blauwe output en

zwart commentaar, kunt u verwijderen door op [ Ctrl ]-[ Delete ] te

drukken. Meestal zult u dat twee keer moeten doen, een keer voor

de (rode) input, en een keer voor de (blauwe) output.

2Zie echter ook §2.2.
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Het gebruik van Maple, inleiding 7

1.5 Variabelen: de toekenningsope-
rator

Het resultaat van een opdracht kan ook worden toegekend aan een

variabele. Zo kan dit resultaat later nog eens worden gebruikt. Dit

toekennen gebeurt middels de toekenningsoperator (of assignment-

operator) :=. Met het commando a := 3; wordt aan de variabele:=

a de waarde 3 toegekend. Dat betekent in grote trekken dat in het

vervolg steeds als de letter a wordt gebruikt, Maple daar automatisch

direct 3 voor invult.

!

Een veel gemaakte vergissing is het gebruik van = in plaats

van :=. Met a = b wordt echter een vergelijking gedefini-

eerd en dat is op zichzelf een Maple-expressie. Door het

commando a = b verandert er dus niets aan de waarde van

a. Men zou zelfs de vergelijking a = b kunnen toekennen

aan de variabele x door de toekenning x := a = b. Zie

verder Module 5.

Met één toekenning kunnen diverse variabelen ‘tegelijk’ elk van een

waarde worden voorzien. Zo heeft

a,b,c := 11,4,6;

hetzelfde effect als

a:=11; b:=4; c:=6;

De aan een variabele toe te kennen waarde hoeft geen getal te zijn,

het mag bijvoorbeeld ook een formule zijn die eventueel zelf varia-

belen bevat. Zo’n formule heet een (Maple-)expressie. Zo zal na de

toekenning

p := a*x∧2 + b*x + c;

telkens als de variabele p wordt gebruikt, deze worden vervangen door

de formule ax2 + bx + c.

Wanneer een waarde is toegekend aan een variabele (bijvoorbeeld aan

a) dan kan deze toekenning ongedaan worden gemaakt door het com-

mando a := ’a’; (en niet door het verwijderen van het statement’ ’

waarin de toekenning werd gedaan). Met deze opdracht wordt als het

ware de variabele a weer vrij gemaakt. Het symbool ’ is de (gewone)

quote, op de meeste toetsenborden te vinden onder het aanhalings-

teken ("). In Module 25 zullen we nader ingaan op het gebruik van

deze quotes.
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8 Module 1

We kunnen ook alle toekenningen in één keer ongedaan maken met

het commando restart. Het is een goede gewoonte om elk nieuwrestart

probleem met het restart-commando te beginnen — tenminste als

daarbij geen gebruik gemaakt zal worden van de resultaten van vorige

berekeningen.

Voorbeeldsessie

> p := a*x^2 + b*x + c;

p := ax2 + bx + c

> a,b,c := 11,4,6;

a, b, c := 11, 4, 6

> p;

11 x2 + 4 x + 6
> a := 7:

p;

7 x2 + 4 x + 6

> b := ’b’: p;

7 x2 + bx + 6

Toelichting

De variabelen a, b, c die in de formule voor p zijn gebruikt, kunnen

we ook later nog een waarde geven. We kunnen deze waarden zelfs

veranderen of weer vrij maken. Merk op dat het intikken van de naam

van een variabele, gevolgd door een puntkomma en de [Enter]-toets

de waarde oplevert die die variabele op dat moment heeft. ⋄

Het is mogelijk om links en rechts van de toekenningsoperator de-

zelfde variabelen te gebruiken, maar men moet er een beetje mee

oppassen. De opdrachten

x := 4: x := x + a;

geven het verwachte resultaat x := 4 + a. Dat komt omdat – in dit

geval – eerst in de uitdrukking rechts van de toekenningsoperator de

bekende waarde van x wordt ingevuld, en vervolgens het resultaat

ervan wordt toegekend aan de variabele met de naam x. Als de

waarde van x iets ingewikkelders is dan een getal, bijvoorbeeld een

matrix, dan gaat het meestal niet goed. Uiteraard gaat het ook mis

als x helemaal geen waarde heeft. Zie verder Module 25.

Namen van variabelen Bijna alle voor de hand liggende letters

en lettercombinaties mogen als naam voor een variabele worden ge-

bruikt. Een paar dingen moet u daarbij in de gaten houden:
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Het gebruik van Maple, inleiding 9

• Er wordt onderscheid gemaakt tussen hoofdletters en kleine

letters. Zo is a een andere variabele dan A.

• Griekse letters kunt u gebruiken als naam, door ze voluit te

typen (lambda wordt λ, enzovoort) of ze uit het palet links

op het scherm te halen.

• Sommige namen kunnen niet worden gebruikt omdat ze al

een vastgelegde betekenis hebben. Beruchte voorbeelden

zijn D en gamma.

Zie verder §2.3

1.6 Verwijzingen

Het resultaat van de laatste opdracht die is uitgevoerd wordt (auto-

matisch) toegekend aan de speciale variabele %.%

!

% verwijst naar de laatste opdracht die is uitgevoerd, en

dat hoeft niet de opdracht te zijn die er op het scherm di-

rect boven staat. Het verdient daarom aanbeveling er een

gewoonte van te maken om % uitsluitend te gebruiken in

dezelfde ‘execution group’ (zie 1.4) als het statement waar-

naar % verwijst.

Evenzo worden de resultaten van de voorlaatste en de voor-voor-

laatste opdrachten toegekend aan de speciale variabelen %% en %%%.%%

%%% Deze variabelen worden wel aangeduid met de term nul-operatoren of

ditto-operatoren.

Voorbeeldsessie

> restart;

> (17+18)/(2*5-1);

35

9
(1)

> p := % + 5;

p :=
80

9
(2)

> # Gevaarlijk

> (17+18)/(2*5-1);
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10 Module 1

35

9
(3)

> p := % + 5;

p :=
125

9
(4)

> # in de bovenstaande regel is "per ongeluk" TWEE keer op [Enter]

# gedrukt.

> (17+18)/(2*5-1): p := % +5; # dit is beter;

# je kunt net zo vaak op [Enter] drukken als je wilt

p :=
80

9
(5)

> # andere mogelijkheid:

> p := (1) + 5;

p :=
80

9
(6)

Toelichting

In het bovenstaande voorbeeld kunt u zien dat het gebruik van % in

een aparte execution group tot rare resultaten kan leiden. Vermijd

dat dus zo veel mogelijk.

Merk op dat elke uitkomst van een berekening een nummer (label)

meekrijgt.3 Deze kunnen we ook gebruiken, zoals we in de laatste

opdracht hebben gedaan. De verwijzing “ (1)” in het commando

p := (1) + 5; kun je maken via Insert Label of [ Ctrl ]-L. en niet

door zomaar (1) te typen. ⋄

1.7 Bewaren van resultaten

Het geheel van alle opdrachten, samen met de resultaten hiervan en

de commentaarregels die op het scherm zijn verschenen sinds het

moment van opstarten van Maple, noemen we een sessie. Er kunnen

verschillende werkbladen tegelijk actief zijn; tezamen vormen deze de

sessie. Denk eraan dat de toekenningen die u maakt normaliter alleen

3Dit is het geval in de standaard-versie. In de Classic Worksheet-versie is

dit niet zo. In het vervolg zullen we die nummers in de voorbeeldsessies dan ook

meestal weglaten.
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Het gebruik van Maple, inleiding 11

gelden voor het werkblad waarin ze zijn gedaan, dus niet in de gehele

sessie.4

Elk werkblad kan gemakkelijk worden opgeslagen op schijf (via het

File-menu). Voor de naam van het bestand moet u zoiets kiezen als

werkblad.mw. Het is belangrijk dat de bestandsnaam eindigt op .mw

(Maple Worksheet); hieraan kan het programma later herkennen dat

het een volledig werkblad betreft. Als u na File → Save as. . . gewoon

de naam werkblad opgeeft, dan zet Maple er automatisch .mw achter.

!
Maak er een gewoonte van om regelmatig uw werk op deze

manier te bewaren. Hiermee voorkomt u dat u alles wat u

gedaan hebt moet overdoen als de stroom uitvalt, als u een

fout maakt waardoor het systeem blijft ‘hangen’, of – niet

denkbeeldig – als u op een fout in Windows stuit.

Als na het starten van Maple, via het File-menu, zo’n .mw-bestand

wordt ingelezen, ziet uw werkblad er precies zo uit als toen het werd

opgeslagen. U kunt echter nog niet direct verdergaan op het punt

waar u de vorige keer was gebleven, omdat Maple de erin voorko-

mende opdrachten nog niet heeft uitgevoerd. Voordat u verder kunt,

zult u dus eerst op elke Maple-opdracht een keer de [Enter]-toets moe-

ten indrukken om de eindtoestand te herstellen (gebruik eventueel de

!!! -knop).

Zie §2.5 voor andere mogelijkheden om (gegevens uit) het werkblad

op te slaan.

1.8 De helpopdracht

Veel vragen kunnen ‘online’ worden opgelost met de helpopdracht.

Deze opdracht wordt aangeduid met het vraagteken. Men kan bij-?

voorbeeld hulp vragen over het commando simplify door ?simplify

te typen. Algemene informatie over het gebruik van de help-faciliteiten

in Maple krijgt u met het commando ?HelpGuide (denk om de hoofd-

letters).

4Dit is de standaard-instelling. Via Tools → Options. . . kunt u Kernel Mode

veranderen in Shared, waardoor alle gemaakte toekenningen in alle werkbladen

geldig zijn.



“mapleV” — 2010/7/12 — 14:02 — page 12 — #14
i

i

i

i

i

i

i

i

12 Module 1

1.9 Enkele praktische tips; veel ge-
maakte fouten

Maple is, zoals gezegd, een interactief programma. Dat betekent dat

u tamelijk onbekommerd van alles kunt uitproberen en alles wat niet

tot het gewenste resultaat leidt weer van het scherm kunt verwijderen.

Weest u daarin vooral niet terughoudend! Maar besef daarbij goed

dat het programma alles onthoudt wat het heeft berekend, óók als de

desbetreffende toekenning van het scherm is verwijderd, tenzij u zélf

uitdrukkelijk aangeeft dat een toekenning ongedaan gemaakt moet

worden (bijvoorbeeld door ’ ’ te gebruiken).

Voorbeeldsessie

> a := 2;

a := 2

> a^2;

4

> a := 3:

Zet nu de cursor op de tweede regel en druk op [ Enter ]. Als u nu ook

nog de laatste regel verwijdert, hebt u een merkwaardige worksheet

gekregen. Veel moeilijk te ontdekken fouten zijn op dit principe terug

te voeren.

In vele gevallen zal het nuttig zijn een ‘blanco’ toestand te creëren

door het commando restart te geven5 en desnoods alle van belang

zijnde commando’s nog eens uit te laten voeren. Denk eraan dat na

restart óók alle eventueel ingelezen bibliotheken en procedures zijn

‘vergeten’.

Als u een (type-)fout gemaakt hebt: lees altijd de door Maple gegeven

foutmelding. Deze is vaak veel informatiever dan zij op het eerste

gezicht lijkt. Bovendien zet Maple vaak de cursor neer op de plaats

van uw invoer waarop het geconstateerd heeft dat er een fout gemaakt

moet zijn. Vanuit dat punt kunt u dan terugzoeken waar de fout

gemaakt is.

Lang niet altijd echter zal Maple een foutmelding geven. Bijvoor-

beeld, als u “ a:5;” typt in plaats van “ a:=5;” dan zal dat worden

opgevat als twee afzonderlijke commando’s, namelijk: “ a: ” (geen

5In een Windows-omgeving kan dit ook met behulp van een knop in de Tool

bar.
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Het gebruik van Maple, inleiding 13

uitvoer wegens de dubbele punt) en “ 5; ”, óók een correct Maple-

statement. De uitvoer op het scherm is dan:

5

in plaats van het verwachte

a := 5

Op dezelfde manier zal “ a=5; ” in plaats van “ a:=5;” ook geen

foutmelding geven. Echter, door “ a=5;” wordt aan a geen waarde

toegekend omdat dit een vergelijking is (zie §5.2). Dit is nog verra-

derlijker dan de vorige fout, omdat de uitvoer op het scherm

a = 5

is, en daaraan valt het niet zo op dat er een dubbele punt ontbreekt.

Als een Maple-commando verkeerd gespeld is, bijvoorbeeld

symplify(p), dan zal Maple niet klagen, maar terugkomen met

symplify(p)

in plaats van de vereenvoudigde vorm van p. Hetzelfde gebeurt als u

een procedure gebruikt uit een bibliotheek die niet geladen is. Als zo’n

‘Maple-woord’ ongewijzigd in de uitvoer terugkomt, dan betekent

dat bijna altijd dat Maple het niet kent. Het is dus van belang om

altijd even in de uitvoer van een Maple-commando op het scherm te

controleren of er geen gekke dingen in staan, óók als die uitvoer er

nogal ingewikkeld uit mocht zien.

Als Maple niet doet wat u verwacht, kunt u het best in eerste instantie

de volgende strategie volgen:

• Controleer of de door u gebruikte variabelen een waarde

hebben die u verwacht. Dit gaat eenvoudig met “ a; ” om

de waarde van a op te vragen.

• Doe restart en voer alle relevante statements in de juiste

volgorde opnieuw uit (vergeet niet de eventueel gebruikte

bibliotheek opnieuw te laden).

Ten slotte, nogmaals: maak er een gewoonte van om regelmatig uw

sessie op te slaan. Doe het in elk geval ook steeds vóórdat u Maple

een opdracht geeft die u niet helemaal vertrouwt.
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14 Module 1

Opgave 1.1

Bereken 3 (4 + 5) met Maple.

Bekijk ook het resultaat van de foutieve invoer

(a) (4+5)3;

(b) 3(4+5);

Opmerking: bij (b) krijgt u geen foutmelding, maar een verkeerd

antwoord. Zie §3.3 voor een verklaring.

Opgave 1.2

(a) Gebruik het Expression-palet om
∫

(x2 + 1) dx te berekenen;

(b) Differentieer het resultaat om het antwoord te controleren.

(c) Dezelfde vragen voor de integraal van eax;

Aanwijzing: Gebruik voor eax niet ab van het palet, maar ea.


